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Femlab 3.1: The Vertical Heated Plate
by
Edward M. Rosen
EMR Technology Group
A vertical heated plate exposed to air has been the subject of experiments, analysis and academic
exercises (Goldstein, 2004, Yang, 2002 ). It is the purpose of this study to compare Femlab 3.1
simulation results to the analytical solution and data.

Problem Description
An isothermal vertical plate at temperature Tw is exposed to air at T∞ . The vertical distance
along the plate is the x direction and its velocity is u. The horizontal direction perpendicular to
the plate is the y direction and its velocity is v.
For this study Tw = 115 C and T∞ = 20 C . Physical properties are evaluated at the average
temperature, 67 C and are considered constant. These temperatures are chosen to be consistent
with selected data (McAdams, 1955).

The Analytical Solution
After simplifications the applicable (boundary-layer) equations are (Bejan, 1995, Boelter, 1948,
Goldstein, 2004, Kays, 1993, Schlichting, 1955)
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Introducing a stream function ψ by putting u =

∂ψ
∂ψ
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∂y
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Setting (Schlichting, 1955)

ψ = 4 υ c x 3 / 4 ξ (η )
η =c

y
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where

c=4

g (Tw − T∞ )
4 υ 2 T∞

(9)

the velocity components become
u = 4 υ x1 / 2 c 2 ξ '

(10)

v = υ c x −1 / 4 (η ξ ' − 3 ξ )
and the temperature distribution is determined by θ (η ) . Substituting Eq (7) into Eqs (5) and (6)
leads to the following ordinary differential equations:
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ξ ''' + 3 ξ ξ ' ' − 2 ξ '2 + θ = 0

(11)

θ '' + 3 Pr ξ θ ' = 0

(12)

with boundary conditions ξ = ξ ' = 0 and θ = 1 at η = 0 and ξ ' = 0 , θ = 0 at η = ∞.
Eqs (11) and (12) can be formulated as a set of five first order differential
equations (Goldstein, 2004)
dξ
= p1
dη

ξ = 0 at η = 0

dp1
= p2
dη

p1 = 0 at η = 0

dp 2
2
= − 3 ξ p 2 + 2 p1 − θ
dη

p 2 unknown at η = 0

dθ
=q
dη

θ = 1 at η = 0

dq
= − 3 ξ Pr q
dη

q unknown at η = 0

(13)

Since p2 and q are unknown at η =0 but known to be = 0 at η = ∞ (taken as η = 12), this is
a two point boundary value problem (Goldstein, 2004). The values of p2 and q at η = 0 have
been tabulated as a function of Pr (Kakac et. al., 1985) and are shown in Table 1.

Physical Properties
Values for the physical properties of air at 67 C were taken from the Fluid Properties Calculator
which can be found at
http://www.mhtl.uwaterloo.ca/old/onlinetools/airprop/airprop.html
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Prepared by Ramesh Krishnamurthy
Kakac et al 1985
Pr
0.01
0.1
0.72
1
2
5
6.7
10
100

p2(0)
0.9873
0.8591
0.676
0.6422
0.5713
0.4818
0.4548
0.4192
0.2517

q(0)
-0.0807
-0.2301
-0.5046
-0.5671
-0.7165
-0.954
-1.0408
-1.1693
-2.1913

ξ (∞)
4.536
1.512
0.5988
0.5253
0.4046
0.3031
0.2786
0.2792
0.1365

Table 1 Values of p2 and q at η = 0

Spreadsheet Calculations
The physical properties of air are recorded on a spreadsheet (Appendix A) and Pr is calculated.
The values of p2 and q are then interpolated from the values given in Table 1 after converting Pr
to ln Pr. This allows the integration of Eqs (13) as shown in the spreadsheet. The integration was
carried out in increments of η = 0.025 up to η = 12. (The spreadsheet shows values of η only up
to 0.575)
The values of u and v at each value of η were calculated from Eqs (10) for x = 0.06 m.
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The Femlab Solution
A tutorial “ heated plate” is supplied by Femlab, 2004 (Version 3.1) and generally guided the
Femlab solution in this study.
Some modifications were made, however :

T − T∞
)
T∞
in the tutorial. This value of ρ is used in both the energy and
T − T∞
hydrodynamic equations. The buoyancy term is Fx = ρ∞ (
) g.
T∞
Choosing T∞ as the temperature at which to evaluate the physical properties (i.e. ρ∞)
in the analytical solution results in the same buoyancy term as in Femlab. However
ρ from the Boussinesq equation is also used in the energy equation in Femlab while
the value of ρ in the analytical solution energy equation would be ρ∞.

1. Femlab uses the the Boussinesq approximation ρ = ρ∞ ( 1 -

As a result the Boussinesq equation was not used in this study’s Femlab simulation.
A constant ρ was used throughout instead at 67 C. This makes the density used in
Femlab the same as used in the analytical solution.
2. The geometry was changed to have the plate on the left side rather than the right.
3

In order to compare the Femlab solution to the analytical, the conditions far from the
plate should be the same. The boundary conditions in the tutorial are indicated in Table
2. However, they do not adequately satisfy the conditions far from the plate:
a) The velocity (u) should drop to zero far from the plate.
b) The value of the velocity, v, (perpendicular to the plate) should
be equal to -0.0153 far from the plate. This derives from evaluation of v
from Eq (10) at η = ∞.
v = c x-1/4 (-3ξ ) = - 0.0153 since ξ’ = 0 and ξ(∞) = 0.603201 (Table 1)
at η = ∞. (x = 0.06)
By trial, the boundary values used in this study to meet the conditions
far from the plate are shown in Table 2.
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Description

No.

1
2
3
4
5
6

Lower Insulated
Bottom
Plate
Upper Insulated
Top
Far Boundary

Femlab Tutorial
Thermal
Flow
Thermal Insulation
Tinf
Tinf + dT
Thermal Insulation
Convective Flux
Tinf

No slip
Neutral
No slip
No slip
Neutral
Neutral

This Work
Thermal
Thermal Insulation
Tinf
Tinf + dT
Thermal Insulation
Tinf
Tinf

Table 2 - Boundary Conditions Compared

Model Navigator
1. Start Femlab – Set Space Dimension to 2D
2. Select General Heat Transfer application in the Heat Transfer Module
3. Click Steady State Analysis.
4. Click the Multiphysics button in the Model Navigator.
5. Click the Add button.
6. Select the Non-Isothermal Flow in the Heat Transfer Module
7. Click the Add button
8. Click OK
Options and Settings
1. Go to the Options menu and define the following physical properties at 67 C.

Figure 1 Constants
2. Click OK.

Flow
No slip
No slip
No slip
No slip
No slip
Neutral
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Geometry Modeling
Fig (1) is the two dimensional geometry of the heated plate. The plate is on the left between PT1
and PT2 , is 0.1 m tall and has isothermal temperature Tw. The short boundaries (0.01 m) below
and above the vertical plate are thermally insulated and are needed to create a smooth flow near
the plates edges. On the bottom, top and right boundary the temperature is set to T∞.
Air will rise upwards towards the upper horizontal boundary. At the top boundary the no slip
specification forces the flow out to the far boundary. The neutral boundary condition means that
no forces act on the fluid.
1. Press the Shift key and click Rectangle/Square button in the Draw toolbar.
2. In the dialog box that appears, enter the following rectangle properties:
Width
Height
Base
x-position
3.
4.
5.
6.

0.105
0.12
Corner
0
y position 0

Click OK
Click Zoom Extents in the Main Toolbar
Press the Shift key and click the Point button in the Draw toolbar.
In the dialog box that appears, enter the following point properties (PT1):
x
y

0
0.01

7. Click OK
8. In the same manner, create a second point (PT2):
x
y

0
0.11

9. Click OK

Note: In Femlab x is the horizontal direction, y is the vertical direction,
Also note that 0.07 m from the bottom of the geometry is 0.06 m
from the bottom of the plate.
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Figure 2. Heated Plate Geometry
Tw = 115 C
Physics Settings
1. Go to the Options menu, find Expressions and then open Subdomain Expressions
Enter Expression for FY

Figure 3 Subdomain Expression
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Subdomain Settings – Non-Isothermal Flow
1. Go to the Multiphysics menu and select Non-Isothermal Flow
2. Go to the Physics menu and select Subdomain Settings
3. Enter the following

Figure 4 Subdomain Settings – Non-Isothermal Flow (ns)
4. Click OK
Boundary Settings – Non-Isothermal Flow
1. Go to the Physics menu and select Boundary Settings
2. Enter the following:
Boundary 1
Boundary 2
Boundary 3
Boundary 4
Boundary 5
Boundary 6

Short lower left side Bottom
Heated Plate
Short top left side
Top
Far right side
-

No Slip
No Slip
No Slip
No Slip
No Slip
Neutral
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3.

Click OK

Subdomain Settings – General Heat Transfer
1. Go to the Multiphysics menu and select General Heat Transfer
2. In the Physics menu, select Subdomain Settings
3. Select subdomain 1 and verify the Enable conductive heat transfer is checked.
4. Enter the properties for Conduction as shown:

Figure 5. Subdomain Settings – General Heat Transfer (htgh) - Conduction
5. Click the Convection tab and select Enable convective heat transfer.
6. Enter the properties as shown.
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Figure 6 Subdomain Settings – General Heat Transfer (htgh) - Convection
7. Click the Init tab.
8. Sect subdomain 1 and type Tinf in the temperature edit field.
9. Click OK
Boundary Conditions – General Heat Transfer
1. Go to the Physics menu and enter the following Boundary Settings
2. Enter the following.
Boundary 1
Boundary 2
Boundary 3
Boundary 4
Boundary 5
Boundary 6

Short lower left side Bottom
Heated Plate
Short top left side
Top
Far right side
-

Thermal Insulation
Temperature - Tinf
Temperature - Tinf + dT
Thermal Insulation
Tempersture Tinf
Temperature Tinf
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3. Click OK
Mesh Generation
1. From the Mesh menu select Mesh Parameters.
2. Click the Boundary tab and select boundaries 1, 3, 4
3. Enter 3e-4 in the Maximum element size edit field.
4. Click the Point tab and select point 2 (PT1)
5. Enter 2e-5 in the Maximum element size edit field.
6. Click Remesh and then click OK.

Figure 7. Mesh Generation
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Computing the Solution
Finding a converged solution is difficult. It is best approached using a small dT ( say 10 K) at
first and slowly decreasing the value of viscosity from about 10 in steps down to the specified
viscosity using the Parametric nonlinear Solver. Once the solution with the required viscosity is
found, then the value of dT is increased to the desired value (95) again using the Parametric
nonlinear Solver.
1. Reset the value of dT in the Constants window to 10.
2. Choose Solver Manager from the Solve menu.
3. On the Initial value page, select Initial Value Expression and Use setting from Initial
Value Frame
4. Choose Solver Parameters from the Solve menu.
5. In the dialog box that appears, select Parametric Nonlinear in the Solver list.
6. On the General page, enter eta (dynamic viscosity) into the Name of the parameter edit
field
7. Type 10 1 .1 1e-2 1e-3 1e-4 1.8205e-5 into List of parameter values edit field.
8. On the Advanced page, set Type of scaling to None.
9. Click OK
10. On the Solve menu, click Solve Problem
The desired solution (dT = 95) is now sought with the eta = 1.8205e-5.
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

Open the Solver Manager from the Solve menu.
On the Initial Value page, click Store solution.
Select the value 1.8205e-5 and click OK.
On the Initial value page, select Stored solution for both Initial Value Expression and Use
setting from Initial Value Frame.
Click OK.
Choose Solver Parameters from the Solve menu.
On the General page, enter dT in the Name of parameter edit field
Type 10 50 90 95 into the List of parameter values edit field.
Click OK.
On the Solve menu, click Solve Problem.
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When the solution is obtained the following results:

Figure 8. Surface Temperature and Arrows Showing Flows

Comparing Femlab, The Analytical Solution and Data
Femlab
The velocity, temperature and temperature gradient profiles are displayed at 0.06 m
from the plate bottom (0.07 m in Femlab) using the Femlab postprocessing procedures. In each
case the ASCII output capability is utilized to obtain a numerical listing in an ASCII file. The
ASCII files are then imported into a spreadsheet. For plotting, interpolation [add-in function
Interp (Rosen, 2004)] is used to obtain the values of interest at pre-determined values of y or x.
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Analytical Solution
Values of the velocity and temperature profiles at 0.06 m from the bottom of the plate are
taken from the spreadsheet solution (Appendix A). The temperature gradient along the plate
at a specified value of x is calculated on the spreadsheet from:

⎡ ∂T ⎤
⎡ Grx ⎤
⎢ ∂y ⎥ = ⎢ 4 ⎥
⎦
⎣ ⎦ y =0 ⎣

1/ 4

(Tw − T∞ )
⎡ ∂θ ⎤
⎢ ∂η ⎥
x
⎣ ⎦ η =0

(14)

Data
Values for the velocity profile at at 0.06 m are read directly from Fig 123 (McAdams, 1955).
Values for the temperature profile at 0.06 m are interpolated from the values at 0.01 m,
0.04 m, 0.09 m, and 0.14 m.
Values from the spreadsheet for the analytical solution (Appendix A), the Femlab solution and
data points are shown in Figs (9-12).
Velocity 0.06 m from Plate Bottom

Velocity - m/s

0.3
0.25
Femlab

0.2

Analytical Solution

0.15

Data from McAdams

0.1
0.05
0
0

0.005

0.01

Distance from Plate - m

Fig 9. Velocity Profile at 0.06 m
Tw − T∞ = 95 C

0.015
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Temperature Profile 0.06 m from Bottom

Temperature K

390
370

Femlab

350

Analytical Solution
Data from McAdams

330
310
290
0

0.005

0.01

0.015

Distance from Plate - m

Figure 10. Temperature Profile at 0.06 m
Tw − T∞ = 95 C

Temperature Gradient -K/m

Temperature Gradient Along Plate
80000
70000
60000

Femlab

50000

Analytical Solution

40000
30000
20000
0

0.005

0.01

0.015

Distance From Bottom of Plate - m

Figure 11. Temperature Gradient Along the Plate
Tw − T∞ = 95 C
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Velocity Perpendicular to Plate(x = 0.06 m)

Velocity Perpendicular to
Plate

0
0

0.02

0.04

0.06

0.08

0.1

0.12

-0.005
-0.01

Analytical Solution
Femlab

-0.015
-0.02
-0.025
Distance From Plate - m

Figure 12. Velocity Perpendicular to Plate

Conclusions
There is very good agreement between Femlab, the analytical solution and data for
the selected values of Tw, T∞ and x (0.06 m). The boundary conditions selected were chosen
so that the Femlab solution would have similar values to the analytical solution far from the plate
The v velocity matches very well near the plate but varies from -0.0153 far from the plate (where
the boundary layer equations may not be valid). The u velocity, however, does tend to zero far
from the plate. In practice it is difficult to specify appropriate boundary conditions.(Bejan, 1995).
The solution (both Femlab and the Analytical solution) is dependent on the temperature chosen
to evaluate the physical properties. Boelter, 1948 (p XII -30) remarks that analytical results
check well with the experimental results of Schmidt and Beckmann, 1930 if the properties are
chosen at Tw. This was difficult to verify since the data of McAdams could only be determined
approximately since it was read from a chart. The data in McAdams are taken from Schmidt ,
1928.
A model’s documentation can be obtained by FileÎGenerate Report.
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Nomenclature
English
cp

specific heat, J/(kg K)

g

gravitational constant,m/s2

Grx

Grashof Number = g ( Tw - T∞ ) x3 /( υ 2 * T∞ )

k

thermal conductivity, J/(s m K)

p1

= ξ’

p2

= ξ’’

Pr

Prandtl Number = cp µ /k

q

= θ’

T

temperature, K

Tw

isothermal temperature of the plate, K

T∞

temperature far from the plate, K

u

velocity in x – direction, m/s

v

velocity in y direction, m/s

x

distance measured from bottom of plate, upward, m

xx

distance measured from bottom of Femlab simulation, m

y

distance measured from lower edge of plate to right, m
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Greek

α

thermal diffusivity,

β

thermal expansion coefficient,

η

independent variable

θ

dimensionless temperature = (T - T∞ }/( Tw - T∞ )

µ

dynamic viscosity kg/(m s)

ξ ( (η )

function in similarity transformation

ρ

density, kg/m3

υ

kinematic viscosity, m2/s = µ / ρ

ψ

stream function

k / ( ρ cp )

-

m2/s

= 1/ T∞

for ideal gas
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Appendix A
Spreadsheet Calculation
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VBA Macro
Option Explicit
Private Function Integ(x, y, prm)
Application.Volatile True
Dim N, IR, nn, I As Integer
Dim h, xx As Single
N = prm(1)
nn = N + 1
ReDim yy(1 To N) As Single
ReDim ddd(1 To nn)
h = prm(2)
xx = x
For I = 1 To N
yy(I) = y(I)
Next
IR = rk4a(N, h, xx, yy, prm)
xx = xx + h
ddd(1) = xx
For I = 2 To nn
ddd(I) = yy(I - 1)
Next I
Integ = ddd
End Function
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Public Function rk4a(N, h, x, y, prm)
'
'Modified from Pedro L. Claveria abril/2002
'based in EMR Technology Group Library
'
'
'n = number of equations
'h = step size for integration
'x = independent variable
'y = vector of dependent variables
'prm = vector parameters
'MsgBox "Entering rk4a" & x & " " & h
ReDim ccc(N), fff(N)
ReDim k1(N), k2(N), k3(N), k4(N)
ReDim y2(N), y3(N), y4(N)
Dim muda1, muda2, muda3, muda4 As Single
Dim I As Integer
'Calculation of k1
muda1 = dydx(x, y, prm, fff)
For I = 1 To N: k1(I) = fff(I): Next
'Calculation of k2
For I = 1 To N: y2(I) = y(I) + 0.5 * h * k1(I): Next
muda2 = dydx(x + h / 2, y2, prm, fff)
For I = 1 To N: k2(I) = fff(I): Next
'Calculation of k3
For I = 1 To N: y3(I) = y(I) + 0.5 * h * k2(I): Next
muda3 = dydx(x + h / 2, y3, prm, fff)
For I = 1 To N: k3(I) = fff(I): Next
'Calculation of k4
For I = 1 To N: y4(I) = y(I) + h * k3(I): Next
muda4 = dydx(x + h, y4, prm, fff)
For I = 1 To N: k4(I) = fff(I): Next
'New values of the dependent variables
For I = 1 To N
ccc(I) = y(I) + (h / 6) * (k1(I) + 2 * k2(I) + 2 * k3(I) + k4(I))
Next I
For I = 1 To N
y(I) = ccc(I)
Next I
rk4a = 0
End Function
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Private Function dydx(x, y, prm, fff)
Dim Pr As Single
Pr = prm(3)
fff(1) = y(2)
fff(2) = y(3)
fff(3) = -3 * y(1) * y(3) + 2 * (y(2) ^ 2) - y(4)
fff(4) = y(5)
fff(5) = -3 * Pr * y(1) * y(5)
dydx = 0
End Function

